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1 INTRODUCTION 

SoundScape is designed to be used by architects, interior designers, and anyone interested in 
understanding the acoustic properties of interior spaces. The program allows you to hear 
sounds, coming from both outside and inside the space, as the occupants would hear them. In 
doing so it takes account of the building materials in the surrounding partitions, and the 
reverberation properties of the room. 

SoundScape is not a replacement for sophisticated acoustic modelling programs, and should not 
be used for the design of concert halls or other spaces where quality of acoustics is critical for 
the performance of the space. Rather, it is intended as an aid in designing acoustics for more 
general spaces such as restaurants, offices and public buildings, where the use of detailed 
modelling programs would not be cost-justified. 

SoundScape also does not remove the need to obtain advice from a qualified acoustic 
consultant on the practical implementation of acoustic treatments, and on acoustic issues not 
covered in SoundScape such as structure-borne noise. Rather, the program is intended to make 
the designer, as well as their client, aware of potential acoustic issues and how they can affect 
occupants' experience of the space. 

This section provides an introduction to the use of the program, including system requirements,  
basic concepts, and some performance issues that may affect the program's operation. Other 
sections deal in more detail with the way sound sources, sound paths and rooms are 
represented, and, for those interested, tools to add additional sounds, partition types and wall 
finishes to the program's library. 

SoundScape Version 1.3 is freely distributed and can be installed on any number of machines. 

However, no warranty is given or implied as to fitness for any purpose, and no liability is 
accepted for any damage or loss caused by use of the program. 
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1.1 Requirements 

To install and run SoundScape, the following is required. 

• Windows PC. Soundscape has been tested on Windows 2000 Professional, XP and Vista. It 
should run on other operating systems, but no guarantees are given. 

• At least 490 MB of free disk space.  This is mostly used to save sound samples. 

• To perform audio simulation, the processor speed should be at least 2.4 GHz. However, 
faster speeds allow more sounds to be replayed simultaneously, and more accurate 
reproduction of reverberation, as described in "System Performance Issues". 

To listen to sounds, of course you need a sound card and either headphones or speakers.  
Headphones are often better because the sound you hear is not influenced by the room you are 
listening in.  However, with headphones you can only make an approximate setting of the 
loudness of the sound.  For the best quality reproduction, listen using good quality speakers in 
a very "dead" room and adjust the sound level as described under "Calibration". 

1.2 Basic Program Concepts 

In SoundScape, sound from one or more sound sources reaches a listener in a room through 
one or more sound paths.  The level (loudness) and quality of the sound depend on 
properties of the sound source(s), the sound paths(s) and the room, all of which you can 
change.  The program shows you the level of sound arriving from each source and each sound 
path, and, assuming you have a fast enough computer, you can hear the sound as it would be 
heard in the room.  The sound sources, sound paths and room properties can all be saved in a 
project file and re-loaded later. 

1.2.1 Sound Sources 

In SoundScape, sound sources are of two types.  Background sound sources are sources that 
don't change much over time and would generally not be noticed consciously.  They are treated 
separately from foreground sources that do change with time and would be noticed if they are 
loud enough.  For background sources, the program shows the LAeq sound level (representing 
the average A-weighted sound level), while for foreground sources the program shows the LAmax 
sound level (representing the maximum A-weighted sound level in the sound file).  For mixtures 
of sounds the program shows the LAeq level. 

Both background and foreground sound sources can be located: 

• outside the room (in an adjacent room or in the external environment), in which case the 
sound will enter the room via a partition; 

• inside the room at a specific point, in which case the listener will be at a certain distance 
from the source; or 

• as diffuse sound in the room (e.g. air-conditioning, a crowd of people, or "masking" noise), 
in which case the sound level is the same throughout the room. 
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1.2.2 Sound Paths 

To be heard by the listener, each sound source needs to be connected to the listener via a 
sound path of the right type.  For sources outside the room, the sound path specifies what type 
of partition the sound travels through (e.g. glazing, brick wall, opening, etc.) and how far the 
listener is from the partition.  For a point source in the room, the path just specifies the 
distance from the source, and for a diffuse source the path doesn't need to specify anything - 
the sound is the same everywhere. 

In SoundScape you create sound paths, then connect sources to them by clicking and dragging.  
You can only connect a source to the appropriate type of sound path for that source.  Several 
sources can be connected to the same path - for example, several types of sound may enter 
the room through the same partition.  In addition, the same source can be connected to several 
paths - for example, the same sound may enter the room through both a window and a wall. 

1.2.3 The Room 

The room itself has properties that affect the sound level and quality of all sound heard in the 
room.  The most important of these properties is the reverberation time, which can be specified 
by octave band between 125 Hz and 4 KHz.  You can enter these values by hand, and the 
sound levels and audible simulation will change accordingly. 

A calculator is also provided that allows you to calculate the reverberation time of a room from 
the room volume and absorption properties of the surface finishes. The calculated reverberation 
time is then written to the main screen. 

1.2.4 Project File 

This saves details of all the sound sources, sound paths and connections between them, as well 
as the room properties.  It also saves details of the latest reverberation calculation performed - 
the room volume used and the type and area of each surface. 

1.3 A Simple Project 

To create a first project in SoundScape, follow these steps. 

1. Start SoundScape and select File > New Project.  You should see empty boxes labelled 
"Background Sound Sources", "Foreground Sound Sources" and "Sound Paths", and a box 
labelled "Room" with some default properties. 

2. Click the label "Background Sound Sources", and the menu item "Add Source".  Select an 
item under "Use Sound from this Library File" - say, section "Traffic" and item "Medium 
Traffic".  Select "Source Location" as "External Environment" and change "SPL outside 
room" to 75 dBA (fairly loud traffic).  Click "OK".  This should show the new source in the 
"Background Sound Sources" box. 

3. Click the label "Sound Paths" and the menu item "Add Sound Path".  Leave "Path Type" as 
"Through a Partition", and don't change the default distance and size of the partition, but 
under "Use Transmission Loss from this Library File", select section "Glazing - Single Fixed", 
item "6mm - Al frame".  (This is a fully glazed wall, 3 m x 10 m.)  Click OK.  This should 
show the new sound path in the "Sound Paths" box. 
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4. Now click in the square at the right of the sound source, and drag to the square to the left 
of the sound path.  The source is now connected to the path.  You can see the sound level 
in the room from that source is 49.4 dBA, LAeq.  If you click the green "Play" button you 
should hear the traffic through the glazing.  Click the ""Pause" button to stop. 

5. Now create a new foreground source by clicking the label "Foreground Sound Sources".  
Use the library file "Speech" / "Male - Maths", and make the source location "Point in 
Room", with SPL at 1m being 67 dBA (typical normal male speaking level).  Click "OK".  You 
now have a foreground source with a sound level of 67 dBA LAmax. 

6. Create a new sound path for this source.  Make the Path Type "In Room, at a Distance", 
and make the distance 5m.  (Keep "Include Direct Sound" checked.) 

7. Connect the second source to the second path.  The LAmax sound level due to this source is 
61.1 dBA, or about 12 dBA above the level of the traffic.  Click "Play" to hear the combined 
sound. 

8. Save the project by selecting menu item File > Save (give it any name). 

You can now introduce other sound sources and sound paths, change the type of wall 
construction, and change the room properties to see (and hear) what effect is has on the 
sound.  The section "Sound Sources, Sound Paths and Rooms" gives more detail on what the 
various options mean and how to use them. 

1.4 Files and System Performance Issues 

Files associated with the project are installed in folder "SoundScape", in the location you 
selected during installation.  This has sub-folders "Library" (for noise source files, partition types 
and wall finishes), "Program" (for program files) and "Project" (the default location for project 
files) and "Help".  You can choose to install or move the files to another folder, but it's best if 
you keep the same sub-folders within the main folder.  Also, when a project refers to a sound 
file it uses the full file path, so if you move the "Library" folder, any saved projects won't work 
because the project won't know where to find the sound files. 

Producing sound in real time is fairly computing-intensive, and slower computers may show 
signs of overloading if you use too many sound sources.  Very slow computers may not handle 
even a single source and path.  The symptom of this is that the sound will break up, with gaps 
between sections of sound.  If this is an issue, you can keep track of how your system is doing 
using Windows Task Manager (accessed by Ctrl-Alt-Delete).  When the CPU usage approaches 
100%, you're in trouble. 

You can ease the computing burden a little by using a less accurate simulation of reverberation.  
A control in the "Room" box allows five levels of accuracy for simulating reverberation.  The 
default is 5, which gives the best simulation.  If your sound is breaking up, try lower levels, 
which use fewer resources but don't sound as good, particularly for long reverberation times.  

Something to note if you're running low on resources is that selecting "Mute" or "Play Alone" for 
a source doesn't speed the system up - the output of unused sources just becomes a string of 
0's.  A better way is to remove the connection from the source to its sound path(s) - this does 
free up some system resources. 
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2 SOUND SOURCES, SOUND PATHS AND ROOMS 

This section provides more details on how to define and use sound sources, sound paths and 
room properties. 

 

2.1 Sound Sources 

To create a new sound source, click on the label "Background Sound Sources" or "Foreground 
Sound Sources" and then "Add Source".  The "Add New Sound Source" dialog appears. 

The source name (top box) can be anything you use to identify the source.  If you don't 
change it from "New Sound Source", it will default to the name of the sound file you select.  
However, if you later edit the source and change the sound file, the source name will not 
change with it - you need to change it yourself. 

The sound file represents one of the files that are saved in the Sound File Library.  These files 
are identified as either "background" or "foreground" - if you're adding a new background 
sound, only the "background" sound files will be shown.  Select a library section in the left-hand 
box, and select the actual file from the right-hand box. 

Source Location can be one of four options.  The Sound Pressure Level (SPL) specified 
underneath has a different meaning depending on the source location selected. 

• Point in Room - the sound source is at a specific, single point in the room.  The SPL is the 
SPL that would be measured at 1m from this source, with no reverberation.  Note that this 
is not the same as the Sound Power Level (SWL) of the source, which is often used to 
specify source strength.  In fact, for the sources considered here, the SWL is the SPL at 1m 
plus 8 dB.  Sources are assumed to be omnidirectional - their sound level does not depend 
on the angle to the listener. 

• Diffuse Source in Room - the source is heard at the same level throughout the room, 
generally because the sound is created by a large number of actual sources (e.g. small 
loudspeakers, or people in a crowd).  Here the SPL specifies the sound level at which the 
source is heard. 

• In An Adjacent Room - sound from the source enters the room from an adjacent room 
through a partition (or a gap in a partition), and the sound path will need to specify the 
area and type of partition involved.  Here the SPL specifies the sound level that would be 
recorded in the adjacent room, close to the partition. 

• External Environment - similar to "In An Adjacent Room", but the sound entering the room 
comes from a non-reverberant environment outside, rather than from another reverberant 
space.  (This affects the amount of sound that is transmitted.) 

Once a sound source is created, it can be edited or removed by clicking on the box at the right 
of the source.  Selecting "Edit" brings up the same dialog box used to create the source.  If the 
source is not connected to a sound path, the "Edit" and "Remove" options are available.  If the 
source is connected to a sound path, you can't change the Source Location to a type that would 
be incompatible with the connected path - for example, you can't change to location "Point in 
Room" if the source is connected to a path that is "Through Partition". 

The "Remove" option is not available for sources that are connected to sound paths. 
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If the source is connected to a path, the additional options "Mute" (set this source to zero 
output) and "Play Alone" (set all other sources to zero output) are available. 

2.2 Sound Paths 

To create a new sound path, click on the label "Sound Paths" and then "Add Sound Path".  The 
"Add New Sound Path" dialog appears. 

The path name (top box) can be anything you use to identify the path. However, it is 
recommended that you use the default name unless you've got a good reason not to.  The 
default name is the name of the partition you select (for "Through a Partition" paths), "Source 
at x m" for "In a Room, at a Distance" paths and "Diffuse Source" for "Diffuse Sound Through 
the Room" paths. If you later edit the path and change the type, the path name will change to 
the default - if you want to give it a different name, you need to edit the name immediately 
before closing the dialog. 

If the path type is "Through a Partition", you need to specify the following: 

• Distance to the partition, m.  This is the distance from the listener to the closest point on 
the partition. 

• Include Direct Sound.  This should normally be checked.  Uncheck the box if the listener will 
be in a position where there is a solid barrier between them and the partition (e.g. they are 
around a corner in the room). 

• Partition Size - approximate if the partition is not rectangular, but try to ensure that the 
area will be correct. 

• Library file for Transmission Loss.  This is selected as for sound sources, and represents the 
construction of the partition.  If there is more than one construction type, treat them as two 
partitions with smaller size. 

If the path type is "In Room, at a Distance", the only things to set are the distance and 
"Include Direct Sound". 

If the path type is "Diffuse Sound Through Room", no other parameters need to be set. 

Once a sound path is created, it can be edited or removed by clicking on the box at the left of 
the path.  Selecting "Edit" brings up the same dialog box used to create the path.  The 
"Remove" option is not available for paths that are connected to sound sources, and in this case 
you can't change the Path Type. 

The “Show Spectrum” option is available if the path type is “Through a Partition”.  This shows a 
graph of the Transmission Loss values for the selected partition (as red squares) – or more 
accurately the opposite of the Transmission Loss values, because they are plotted as negative 
numbers.  It also shows the performance of the audio filter that the program has used to 
simulate the partition (as a blue line).  Soundscape’s audio filters are optimised to produce a 
reasonable simulation with low resource usage – this graph gives an idea of how close the 
simulated sound will be to the actual sound. 
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2.3 Connecting Sources and Paths 

To connect a sound source to a path, click and drag from the box at the right of the source to 
the box at the left of the path.  Only the following connections are allowed: 

• Source location "Point in Room" to path type "In Room, at a Distance" 

• Source location "Diffuse Source in Room" to path type "Diffuse Sound through the Room" 

• Source location "In an Adjacent Room" or "External Environment" to path type "Through a 
Partition". 

You can connect more than one source to the same path, and the same source to more than 
one path. 

The sound path will show the SPL heard by the listener from all sources using that path.  If 
there is only one source connected and that is a foreground source, then the path shows the 
LAmax sound level - otherwise it shows the LAeq level. 

A connection can be removed by clicking on the connecting line and selecting "Remove 
Connection". 

 

2.4 Room Properties 

The room's reverberation time (RT) can be set for each octave band between 125 Hz and 4 
KHz.  When you click in one of the boxes used to set the RT, the value shows in magenta, 
indicating that it is being edited, but no changes have been made to the program's 
reverberation processor yet.  When you leave the box, the value you have entered is checked.  
If the entered value is OK then the reverberation processor is re-configured and the value 
returns to black. 

The same is true for the boxes showing the room's length, width and height, which are used to 
set more subtle properties of the program's reverberation processor.  These values don't need 
to be exact, and the implied room volume doesn't need to match the volume used to calculate 
reverberation time. 

While changing these boxes (or the "Simulation Accuracy" setting), it is best to pause the audio 
playback - otherwise more strain is put on the machine's computing resources. 
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2.5 Calculating the Reverberation Time 

Soundscape includes a tool to help you calculate the reverberation time of a room using the 
Sabine formula 

 
RT(f) = 0.16 V / A(f) 

 

where RT(f) is the reverberation time in seconds as a function of frequency f, V is the room 
volume in cubic metres, and A(f) is the total absorption in the room, in metric sabines (also a 
function of frequency).  A(f) is defined as 

 

A(f) = ∑ αi(f) ai 
 

where αI(f) is the sound absorption co-efficient of room surface i, and ai is its area. 
 

Clicking “Calculate Reverb. Time” in the Room box brings up a calculation screen.  Initially the 
room volume is just the value implied by the three room dimensions in the Room box, but 
change this if it’s not accurate.  Then you can add surfaces of various types, with their areas, 
and the reverberation time is calculated in octave bands between 125 Hz and 4 KHz. 

If you click OK, the reverberation time you’ve calculated is transferred to the Room box in the 
main form, and the reverberation processor is re-configured. 

It’s best if you pause the audio playback before doing this calculation, once again to save the 
machine’s resources. 
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2.6 Calibrating the Sound Level 

The simulated sound gives a better indication of what it would actually sound like in the space if 
the sound pressure level you’re hearing matches the SPL shown on the screen.  You can do this 
using the Calibration procedure. 

If you click “Calibrate” on the main screen (top right), you can produce a constant “whooshing” 
sound (high-pass filtered pink noise if you want the technical description).  If the SPL from this 
sound is 70 dBA* at your listening position, then the SPL from all the other sounds produced by 
the program will be correct at that position. 

The only way to make the calibration accurate is to use loudspeakers, in a very “dead” room, 
and use a sound level meter to measure the level of the “calibration” sound.  Then adjust the 
level being produced by the speakers until it measures 70 dBA*.  (You can adjust it by using the 
computer’s “Volume Control” setting.) 

If you’re using headphones or you don’t have a sound level meter, you can get it approximately 
right by adjusting the calibration sound until it would be difficult to understand (not difficult to 
hear) a normal male voice at 2 m. 

Instructions are given on the screen that appears when you push “Calibrate”. 

 

2.7 The Peak Level Meter 

The “Peak Level” meter next to the “Play” button monitors the total audio signal being 
produced by SoundScape.  If you ask for a sound level that is too high, the program can 
produce a signal that will overload the computer’s sound card, producing a distorted output.  
This is a particular issue for low-frequency sound, which may produce a high peak level even 
though the A-weighted SPL is moderate. 

Distortion is indicated when the peak level exceeds the highest mark on the scale, and the bar 
turns red.  The other marks are at intervals of 10 dB below the distortion level. 

By default, the maximum peak sound level before distortion is 90 dB.  (Note this is a “linear” 
sound level – it doesn’t relate directly to the A-weighted SPL.)  If you need to produce higher 
sound levels than this, you can increase the maximum level through the “Settings …” menu 
item.  If you do this, you will need to re-calibrate if you want the actual sound level to be 
accurate.  Increasing the “maximum peak sound level before distortion” means quiet sound will 
not be reproduced quite as well.  Change it back down to 90 if you don’t need it to be higher. 

One point to note is that the maximum peak sound level is stored with the program settings, 
not with the project.  If you change this value it will be changed for all projects, and will stay 
changed if you close and re-open the program. 

                                                
* 70 dBA is the default SPL for calibration, and is suitable for most cases.  You can alter the SPL 
used for calibration through the “Settings …” menu item (see Section 2.8). If you change this 
value, calibration can only be performed by measurement with a sound level meter. 
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2.8 Changing Program Settings 

Several settings can be changed using the “Tools” > “Settings …” menu item. 

• “Maximum Peak Sound Level Before Distortion”:  this is described in Section 2.7. 

• “SPL for Calibration”:  Sets the SPL that you should measure when calibrating the output 
sound level.  I can’t think of a good reason for wanting to change this from the default of 
70 dBA, unless the environment is very noisy (in which case your simulations won’t be very 
useful) or your sound system can’t generate 70 dBA at the measurement position (in which 
case you won’t be able to generate most sounds that you’d normally be interested in).  
However the option to change it is there. 

• Location of library files:  The “Audio Files”, “Partition Types” and “Wall Finishes” libraries 
are stored by default in a “Libraries” folder within the general “SoundScape” folder, which 
was saved on installation of the program.  You can change the location of these files using 
the appropriate “Browse …” button.  This allows you, for example, to maintain several 
separate libraries for different purposes (see Section 3).  The “Default” button will reset the 
library to the default location. 

Note that the “Audio Files” library doesn’t contain the actual audio files – just the name and 
path of each file and information about the spectrum. 
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3 EDITING THE SOUNDSCAPE LIBRARIES 

Soundscape is installed with libraries of audio files, partition types and wall finishes that you can 
select.  You can add to, remove or edit the items in these libraries using the procedures 
described in this section. 

Please note that if you add to or alter the supplied libraries, SoundScience takes no 
responsibility for any problems that may arise, either within the program or because the 
material you enter may be incorrect. 

Also, if you add audio files containing material that is subject to copyright or other restrictions, 
you are solely responsible for any consequences. 

 

3.1 Common Procedures for All Libraries 

Open one of the libraries using one of the items under the “Tools” menu on the main screen – 
an “Edit Library” dialog appears.  Each library is divided into Sections, which just serve to group 
similar items together.  You can create a new Section using the “Add Section” button at the 
bottom of the library dialog.  “Remove Section” removes the section AND ALL ITEMS IN IT – be 
careful. 

When a Section is selected in the left-hand box, you can add an Item to the Section, or view or 
remove the item selected in the right-hand box, using the appropriate buttons.  Details for 
adding and editing items in each library are in the following sections. 

 

3.2 Adding Audio Files 

Audio files to be added to SoundScape MUST be in WAV format, 16-bit, stereo, and sampled at 
44,100 samples per second.  If you don’t know what this means, you shouldn’t be adding audio 
files to SoundScape. 

The files should be reasonably short – 2 minutes would be the maximum required and often 30 
seconds is fine.  Use an audio editor such as Audacity to select the section of audio you need, 
and save it as a separate file. 

When you add a sound file to the library, what is saved is the location of the file – the file itself 
can be anywhere on your computer.  However, it is recommended that you keep SoundScape 
audio files in the “AudioFiles” sub-folder of SoundScape’s “Library” folder – that way they don’t 
get lost. 

When you click “Add Item” to add a new audio file, the first thing you should do is select the 
file location.  The program will then analyse the file to find the level and spectrum of the sound 
it contains.  It calculates the spectrum corresponding to the LAeq, LAmax and LAmin levels in the 
file, relative to 0 dB being the highest sound level that could be stored without distortion.  This 
process may take several minutes, depending on the length of the file and the speed of your 
machine. 

When the file is analysed, supply a display name for the new sound, and make sure you select 
whether this is a background or foreground sound.  You can then use this sound in simulations. 
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You can view an existing audio file, and see all three spectra, but you can’t change any of the 
properties once it has been saved. 

 

3.3 Adding and Editing Partition Types 

To add a new partition type, just give the material a name and add its Sound Transmission Loss 
(STL) values at third-octave band centre frequencies.  Ideally the STL should be specified for all 
frequencies between 100 Hz and 10 KHz, but often it’s only known between 125 Hz and 5 KHz 
and this is OK – just leave the others blank. 

When viewing partition types, you can change the transmission loss values, but not the names. 

When adding or viewing a partition type, Rw value is calculated and shown.  You can use this 
to find the Rw values of the partitions you use in your design. 

 

3.4 Adding and Editing Wall Finishes 

To add a new wall finish, just give it a name and add its sound absorption co-efficients at 
octave band centre frequencies between 63 Hz and 8 KHz.  Please fill in all the frequencies, 
even if you’re guessing – blanks may lead to strange results when calculating reverberation 
times. 

When viewing wall finishes, you can change the absorption co-efficients, but not the names. 

When adding or viewing a wall finishes, the NRC (Noise Reduction Co-Efficient) is calculated 
and shown.  You can use this to find the NRC values of the partitions you use in your design. 

 

 

 


